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§１ Overview 

This manual describes how to operate the 0.1 μm Particle Counter 

Measurement Software. This software remotely controls the 0.1 μm 

Particle Counter. It monitors and displays the measured data. The data 

can be saved in CSV format. 

1) Software Specifications 

Item Details 

OS Microsoft Windows 10 

Language English, Japanese 

Communication Mode TCP/IP (wired), Serial communication 

2) Operating Environments 

OS Microsoft Windows 10 

Interface Ethernet, RS-485 

RAM 4 GB or more 

HDD Capacity With free space of 500 MB or more 

Compatible Model Model 3950 
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§２ Software Setup 

1）Prior to  the software setup, exit other programs.   

Open the folder  on the CD.  

According to your Windows version, open  or  on the 

CD. 

Double-click the setup file to display the dialog box as 

shown in Figure 2-1. 

 

Figure 2-1 Initial Setup Dialog Box 
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2）Click the Next button to display the dialog box as shown in Figure 

2-2. The default location to install is the C drive. To install into a 

different drive or a folder, click “Browse...” and choose the required 

location.   

 
 
 
 
 
 
 
 

 

Figure 2-2 Select Installation Folder Dialog Box 

 

3) Click the Next button to display the dialog box as shown in Figure 

2-3. 

 

Figure 2-3 Confirmation Installation Dialog Box 
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4）Click the Next button to display the dialog box as shown in Figure 

2-4. 

  

Figure 2-4 Installation progress Dialog Box 

 

 

5) When the installation completed, the dialog box as shown in Figure 

2-5 will appear. 

 

Figure 2-5 Installation Complete Dialog Box 

6) Click the Close button to complete the setup. 
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§３ Main Unit Settings  

1) Settings the Main Unit Communication 

Step 1 Step 2 

Turn on the Main unit to display the Main 

screen.  

On the Main screen, tap the Measurement 

Setting button to display the Measurement 

Setting screen below. 

 

 

Step 3 Step 4 

On the Measurement setting screen, tap 

the Remote button to display the Remote 

Control screen below. 

 

 

On the Remote Control screen, tap the 

Setting button to display the Remote 

Setting screen below. 

 

Step 5 

Choose the communication method and set communication parameters. 

Ethernet RS485 

  

Step 6 Step 7 
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Tap the ✔ button to complete the setting. 

To return to the previous page, tap the 

Return button. 

 

The Remote measurement screen will 

appear, when connecting with the 

Connection button. 

2) Connecting the Hardware  

Ethernet direct connection between the main unit and the 

PC: Connect with a cross LAN cable as shown below. 

       

Remote setting>Ethernet  Communication Parameters 

 Port number︓502 

IP address︓192.168.5.11 

Subnet mask︓255.255.255.0 

Default gateway︓0.0.0.0 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3-1 

Cross LAN Cable 
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If you connect the main unit and PC directly, you need to change the IP 

address of the PC. 

1) Open the Control Panel. 

2) Click the Network and Internet. 

 

 

 

 

 

 

 

 

 

 

 

3) Click the Network and Sharing Center. 

 

 

 

 

 

 

 

 

 

4) Click the Change adapter settings. 

 

 

 

 

 

 

 

 

5) Right-click the Ethernet icon, and click the Properties. 
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6) Select the Internet Protocol Version 4 

 (TCP / IPv4) and cl ick the  Properties.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7) Select the Use the following IP address. Enter "192.168.5.1" in the IP 

address, "225.255.255.0" in the Subnet mask, and click the OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8) Close all the windows you opened. 
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Ethernet connection using LAN network: Using LAN cables to 

connect as shown in Figure 3-2, Figure 3-3.  

Remote setting>Ethernet Communication Parameters 

Auto ☑ :Checked 
Obtain IP address, subnet mask, 

and gateway from the network 

automatically. 

Auto □ :No check 
Enter the IP address, subnet mask, 

and gateway. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  Figure 3-3  2 or more Device connection 

LAN Cable 
LAN Cable 

LAN Network 

LAN Cable 
LAN Cable 

LAN Network 

LAN Cable 

Figure 3-2  1-Device connection 
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RS-485: If the PC does not have RS-485 communication port, use a 

2-wire USB-RS485 converter. 

Remote Setting > RS485 Communication parameters 

Enter or select. Enter the ID. 

Baud rate: 9600, 19200, or 38400 

Parity: none, even, or odd 

Stop bit: 1 or 2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Figure 3-5  2 or more Device connection 

RS-485 Communication Cable 
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Figure 3-4  1-Device connection 
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§４ Using the Software 

4.1 Starting the software (the Main Screen) 

Click the icon on the start-menu  to start the 

software. The main screen appears as shown in Figure 4-1. 

 

 

 
Figure 4-1 Main Screen 

 

Item Details 

Particle graph Shows the value of the particle count 

Data table Shows the measurement data of particles 

Status (Contents in the table blow.) 

 

Item Details 

Measurement status Sampling, Waiting 

Measurement parameter Sampling time, Interval time, Repeat count 

Communication mode Ethernet, RS485 

Open the Main screen. While holding down the Ctrl key, press the D key on the 

keyboard to display the Data Display Software: Measurement Screen (Chapter 

10). For details, please refer to Chapter 10. 

 

Particle 

Graph 

Data Table 

Status 

Name of Software 
Menu 

Tool bar 
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4.2 Measurement procedures 

 1) Configure the communication mode setting.  

STEP1   STEP2 

Click the Select Communication Mode on 
the Set menu. 

 

Select the Communication Mode. 

 

STEP3 STEP4 

Ethernet RS485 While the remote 

control of the 0.1μm 

Particle Counter. is 

on the stand-by, 

click the OK button 

to connect. 

Set the IP address of  

the 0.1 μm Particle Counter. 

 

Set the communication 

parameters. 
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2) Start a measurement. 

 

STEP3 

Click the Start Measurement on 

the Measure menu to start a 

measurement. 

 

 

 

 

STEP1 STEP2 

Click the Setting in the Measure 

menu. 

 

 

Set the parameters in the Measure Start 

Setting. 
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§５ File 

Use this menu to open the existing data files, save the data files, and 

close the applications.  

 

 

Figure 5-1 File Menu 

 

5.1 Open 

Open the data files（*.CSV）to display a particle graph and particle data. 

On the File Menu (Fig. 5-1), click  to display the 

Opening Data File Dialog Box as shown in Figure 5-2. 

 (Using the button on the toolbar or the Ctrl key + the O key on the 

keyboard are also allowed to access the dialog box in Fig. 5-2.） 

 

Figure 5-2 Opening Data File Dialog Box 

: Opens the data file. 

: Cancels the command. 
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5.2 Save 

Use this menu to save the measured data and the measurement 

parameters (*.CSV formats).  

On the File Menu (Fig. 5-1), click  to open the Save As 

Dialog Box as shown in Figure 5-3. 

 (Using the  button on the toolbar or the Ctrl key + the S key on the 

keyboard are also allowed to access the dialog box in Fig. 5-3. 

 
Figure 5-3 Save As Dialog Box 

 

       : Saves the data file. 

        : Cancels the command. 

 

5.3 Exit 

On the File Menu (Fig. 5-1), click the Exit button to complete. 
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§６ Setting  

Use this menu to set the communication mode and the communication 

parameters. Select the measurement mode before starting a 

measurement. 

 

Figure 6-1 Setup Menu 

 

6.1 Selecting the communication mode 

On the Setup Menu (Fig. 6-1), click the Select Communication Mode 

to open the Select Communication Mode Dialog Box as shown in the 

Figure 6-2. 

 (Using the  button on the tool bar is also allowed to access the 

dialog box in Fig. 6-2.) 

 

Figure 6-2 Select Communication Mode Dialog Box 

 

Choose Ethernet  or RS485. 

︓Shows the parameter setting screen on the selected 

communication mode. 

︓Cancels the command. 
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6.2 Setting the IP address 

Using with the LAN cable, connect the PC and the 0.1μm Particle 

Counter. 

Ethernet 

On the Setup Menu (Fig. 6-1), click the Ethernet Set to display the 

Ethernet Setting Dialog Box as shown in Figure 6-3. 

 

Figure 6-3 Ethernet Setting Dialog Box 

 

  1）Parameter settings 

Enter the port number and the IP address set on the 0.1μm 

Particle Counter main unit. 

 

2）Button functions 

 : Saves the parameters and connects. When the 

connection completed, the success message will be 

displayed. When the connection is failure, a failure 

message will be displayed. If a connection error 

occurs, check the connection status. 

  : Cancels the command. 
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6.3 RS-485 Setting 

On the Setup Menu (Fig. 6-1), click the RS485 Set to open the RS 485 

Setting Dialog Box as shown in Figure 6-4. 

 

 

Figure 6-4 RS485 Setting Dialog Box 

Note: When setting the port, be sure to confirm the communication port 

connected to the main device and the PC. 

 

1）Parameter settings 

 Enter the communication parameters set on the 0.1 μm Particle 

Counter main unit.  

Item Details Remarks 

Port COM1, COM2 … COM255 Selectable 

ID 1, 2, 3 … 247 Input possible 

Baud rate 9600, 19200, 38400 Selectable 

Parity None, Even, Odd Selectable 

Data bit 8 Fixed 

Stop bit 1 or 2 Selectable 
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2）Button functions 

 : Saves the parameters and opens the port. When the 

port is connected properly, the success message will 

appear. When a port error occurs, a failure message 

will appear. If a connection error occurs, check the 

connection status. 

      : Cancels the command. 
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§７ Setting the Measurement Parameters and Start 

Measurement 

Use this menu to set the measurement parameters, start a 

measurement, and stop a measurement. 

 
Figure 7-1 Measure Menu 

 

7.1 Setting the measurement parameters 

Click the Setting on the Measurement Menu to display the Measure 

Parameter Set Dialog Box as shown in Figure 7-2. 

 

Figure 7-2 Measure Parameter Set Dialog Box 

1）Parameter Settings 

Item Details Remarks 

Sample time 6 to 5999 seconds Possible to Input 

Interval time 6 to 5999 seconds Possible to Input 

Sample cycle 1 to 9999 pcs. Possible to Input 

Size distribution 0.1 µm, 0.3 µm Selectable 
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2）Button functions 

: Saves the measurement parameters. 

: Cancels the command. 

 

7.2 Start measurement 

On the Measure Menu (Fig. 7-1), click the Start Measurement . 

 (Using the button is also the same function with the above.) 

 

Measurement window 

 

Figure 7-3 Measurement Window 
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7.3 Stop measurement 

On the Measure Menu (Fig. 7-1), click the Stop Measurement to 

display the Confirm Message Dialog Box as shown in Figure 7-4. 

 (Using the button on the tool bar is allowed to access the dialog box 

in Fig. 7-4.) 

 

Figure 7-4 Confirm Message Dialog Box 

    : Stops the measurement. 

 : Cancels the command. 
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§８ View 

Use this menu to set the particle graph. 

 

Figure 8-1 View Menu 

8.1 Setting the parameter in the particle graph 

Click the Particle Graph Parameter Edit on the View Menu (Fig. 8-1) 

to display the Particle Graph Parameter Edit Dialog Box as shown in 

Figure 8-2.  

(Using the button on the toolbar is also allowed to access the dialog 

box in Fig. 8-2.) 

 

Figure 8-2 Particle Graph Parameter Edit Dialog Box 

 

 

 

 

 

 

Range of  
X-Axis 

Size 
Distribution 

Graph Type 

Range of 
Y-Axis 
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   1) Parameters 

Item Details Remarks 

Range of X-axis 1, 2, 3, 4, 5, 10，20，30，40，

50，60 minutes 
Selectable 

3, 6, 12, 18, 24 hours 

0, 20, 30 days 

Size distribution 0.1 µm, 0.3 µm Selectable 

Graph type Linear graph, Logarithmic graph Selectable 

Range of Y-axis 10,20,50,100, … 1.00E+9 Selectable 

 

2）Button functions 

 ︓ Saves the graph parameters. 

 ︓ Cancels the command. 
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§９ Help 

Use this menu to display the software title and version information. 

 

 
Figure 9-1 Help Menu 

 

9.1 About 

Click the About on the Help Menu (Fig. 9-1) to display the About 

(version information) as shown in Figure 9-2. 

 

 

 

 

 

 

 

 

 

 

Figure 9-2 About (Version information) 
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§１０  Data Display Software: Measurement Screen 

10.1 Data Display Software: Measurement Screen 

Display the Main Screen (Fig. 4-1 in Chapter 4). While holding down 

the Ctrl key, press the D key on the keyboard. Perform a 

measurement on the same screen with the Main screen of the 0.1μ

m Particle Counter. main unit. The Data Software: Measurement 

Screen as shown in Figure 10-1 will appear. 

 

 

 

 

 

Figure 10-1 Data Display Software: Measurement Screen (1-Device Connection) 

1) Parameters 

Item Details 

Measurement Value Particle measurement data 

Location No. Setting location (No.) 

Repeat Count Count up to the number of times of a set repeat count 

Remaining Time Remaining time to the next step 

Measurement Mode Display a set measurement mode 

Text Box (Optional) Input texts up to 500 characters. 

Data Saving Check 

Box 

Indicate whether or not the measured data saving is 

required. 

IP/ID Connection 

Information 

For Ethernet connection, IP information is displayed. 

For RS485 connection, ID information is displayed. 

Measurement 
Value 

Software Name 

Repeat Count 

Measurement 
Mode 

Location No. 

Remaining 
Time 

Text Box 

Data Saving 
Check Box 

IP/ID Connection 
Information 
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2）Button functions 

 ︓ Starts measurements in all connected devices. 

 ︓ Stops measurements in all connected devices. 

 ︓ Displays the Mode Selection Screen (Chapter 12). 

 ︓ Displays the Select Communication Mode Dialog Box 

(Chapter 11). 

 ︓  Switches readings that represent each device 

between Cumulative ∑ and Differential Δ . 

 ︓ Starts/Stops measurements in each device. 

︓Displays the Mode Selection Screen (Chapter 12) of the device that the 

screen with this icon shows. 

 

The layout of the Measurement Screen depends on how many 

devices (up to four devices) are connected. Checking the check box 

on the screens of 11.2 Setting the IP address or 11.3 Setting 

RS-485 (Chapter 11. Communication Settings) allows you to 

designate the number of device to be connected.  

 

 

Figure 10-2 Data Display Software: Measurement Screen (2-Device Connection)  
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Figure 10-3 Data Display Software: Measurement Screen (3-Device Connection) 

 

 

Figure 10-4 Data Display Software: Measurement Screen (4-Device Connection) 

 

Display the Data Display Software: Measurement Screen. While 

holding down the Ctrl key, press the D key on the keyboard to 

display the Main Screen (Fig. 4-1 in Chapter 4). For the operation of 

the Main Screen, please refer to Chapter 4. 
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§１１  Communication Settings 

In this chapter, set communication modes, communication 

parameters and the number of device to be connected. 

Select the measurement mode before starting a measurement. 

 
Figure 11-1 Communication Setting Button 

 

11.1 Selecting the communication mode 

Click the Communication Setting Button on the Measurement 

Screen to display the Select Communication Mode Dialog Box as 

shown in Figure 11-2. 

 

 
Figure 11-2 Select Communication Mode Dialog Box 

 

Choose Ethernet or RS485. 

︓Shows the parameter setting screen on the selected 

communication mode. 

︓Cancels the command. 
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11.2 Setting the IP address 

Using with the LAN cable, connect the PC and the 0.1μm Particle 

Counter. 

Ethernet 

On the Setup Menu (Fig. 11-2), click the Ethernet Set to display the 

Ethernet Setting Dialog Box as shown in Figure 11-3. 

 
Figure 11-3 Ethernet Setting Dialog Box 

 

  1）Setting Parameter 

Checking the check box of the IP Address allows you to enter IP 

address. 

Check the check box to meet the number of device to be 

connected. 

Enter the port number and the IP address set on the 0.1μm 

Particle Counter main unit. 

 

2）Button functions 

 : Saves the parameters and connects. When the 

connection completed, the success message will be 

displayed. When the connection is failure, a failure 

message will be displayed. If a connection error 

occurs, check the connection status. 

  : Cancels the command. 
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11.3 Setting RS-485 

On the Setup Menu (Fig. 11-2), click the RS485 Set to open the RS 485 

Setting Dialog Box as shown in Figure 11-4. 

 

Figure 11-4 RS485 Setting Dialog Box 

Note: When setting the port, be sure to confirm the communication port 

connected to the main device and the PC. 

 

1）Parameter settings 

Checking the check box of the ID allows you to enter ID. 

Check the check box to meet the number of device to be connected. 

Enter the communication parameters set on the 0.1 μm Particle 

Counter main unit.  

Item Details Remarks 

Port COM1, COM2 … COM255 Selectable 

ID 1, 2, 3 … 247 Input possible 

Baud rate 9600, 19200, 38400 Selectable 

Parity None, Even, Odd Selectable 

Data bit 8 Fixed 

Stop bit 1 or 2 Selectable 
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2）Button functions 

 : Saves the parameters and opens the port. When the 

port is connected properly, the success message will 

appear. When a port error occurs, a failure message 

will appear. If a connection error occurs, check the 

connection status. 

      : Cancels the command. 
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§１２ Measurement Settings 

Configure each parameter in the measurement mode. 

 

Figure 12-1 Measurement Setting Button 

 

Figure 12-2 Batch Processing Measure Setting Button 

12.1 Measurement Mode Selection Screen 

Click the Individual Processing Measurement Setting Button (Fig. 12-1) 

or the Batch Processing Measure Setting Button (Fig. 12-2) on the 

Measurement Screen to display the Mode Selection Screen as shown in 

Figure 12-3. 

When clicking the Individual Processing Measurement Setting Button, 

IP/ID information will be displayed as a window-name as shown in 

Figure 12-4. 
 

 
 

 

Figure 12-3 Mode Selection Screen 

 

 

Figure 12-4 Display of Window-Name  

When Clicking Individual Processing Measurement Setting Button 

Measurement Mode 
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1）Button functions 

︓Use this button to display the screen to set up the Repeat mode. 

︓Use this button to display the screen to set up the Single mode. 

︓Use this button to display the screen to set up the Continuous 

mode. 

︓Use this button to display the screen to the Calculation mode. 

 

︓Use this button to close the current screen. 

 

 

12.2 Measurement Mode 

When the Mode Selecting Screen (Fig. 12-3) is displayed by clicking 

the Individual Processing Measurement Setting Button (Fig. 12-1), 

IP or ID information will be displayed as a window-name. 

In this case, only measurement modes in the screen that applies can 

be set.  

When the Mode Selecting Screen is displayed by clicking the Batch 

Processing Measure Setting Button (Fig. 12-2), measurement 

modes in all the screens can be set. 

 

1）Repeat Mode 

Click the Repeat button on the Mode Selection Screen (Fig. 

11-3) to display the Repeat Mode as shown in Figure 12-5. 
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Figure 12-5 Repeat Mode 

 

1-1）Parameter Settings 

Item Details Remarks 

Location 1 to 99 Possible to input 

Sampling Time 6 s to 99 m 59 s Possible to input 

Repeat Count 2 to 9999 Possible to input 

Interval Time 6 s to 99 m 59 s Possible to input 

 

1-2）Button functions 

︓Use this button to cancel the setting and close the current window. 

 

︓Use this button to save the setting and display the Data Display 

Software: Measurement Screen. (Fig. 10-1) 
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2）Single Mode 

Click the Single button on the Mode Selection Screen (Fig. 12-3) 

to display the Single Mode screen as shown in Figure 12-6. 

 

 

Figure 12-6 Single Mode 

 

2-1）Parameter Settings 

Item Details Remarks 

Location 1 to 99 Possible to input 

Sampling Time 6 s to 99 m 9 s Possible to input 

2-2）Button functions 

︓Use this button to cancel the setting and close the current screen. 

 

︓Use this button to save the setting and display the Data Display 

Software: Measurement Screen. (Fig. 10-1) 
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3）Continuous Mode 

Click the Continuous button on the Mode Selection Screen (Fig. 

12-3) to display the Continuous Mode shown in Figure 12-7.  

 

 

Figure 12-7 Continuous Mode 

 

3-1）Parameter Settings 

Item Details Remarks 

Location 1 to 99 Possible to input 

 

3-2）Button functions 

︓Use this button to cancel the setting and close the current screen. 

︓Use this button to save the setting and display the Data Display 

Software: Measurement Screen. (Fig. 10-1) 
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4) Calculation Mode 

Click the Calculation button on the Mode Selection Screen (Fig. 

12-3) to display the Calculation Mode as shown in Figure 12-8. 

 

 

Figure 12-8 Calculation Mode 

 

4-1）Parameter Settings 

Item Details Remarks 

Location 1 to 99 Possible to input 

Sampling Time 6 s to 99 m 59 s  Possible to input 

Repeat Count 2 to 9999 Possible to input 

Interval Time 6 s to 99 m 59 s Possible to input 

 

4-2）Button functions 

︓Use this button to cancel the setting and close the current screen. 

︓Use this button to save the setting and display the Data Display 

Software: Measurement Screen. (Fig. 10-1) 
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12.3 Starting Measurement 

Click  or  to start measurement. 

 

12.4 Stopping Measurement 

Click  or  to stop measurement. 

If you have checked the Data Saving Check Box in advance and there are 

valid results, when the measurement is completed, or stopped by tapping 

the button, the File Saving Dialog Box will appear. The results can be stored.  

(*.CSV format) 

 

 

Figure 11-8 File Saving Dialog Box 

︓Tap this button to save data. 

︓Tap this button to cancel the current command. 
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§１３  Troubleshooting 

When using the RS485-USB conversion cable (hereinafter, the “conversion cable”), 

if communication errors occur repeatedly, the change of the device settings for the 

conversion cable can result in avoiding communication errors. 

 

 (Example) If FTDI Chipʼs conversion cable is used, 

      ・ Open the Device manager. 

 

 

 

 

 

 

 

 

 

 

      ・ Expand Port (COM and LPT), and right-click the USB Serial Port (COMx) 

        Choose Properties on the menu and click Properties.  

      ・ Click Advanced on the Port Settings.  
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      ・ When the Advanced Setting screen appears, change Latency Timer in the 

BM Options from 16msec to 1msec, then click OK.  

        Close the properties screen to complete the settings. 
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§１４ Contact Information 

 

 

 U.S.A. 

KANOMAX USA, INC. 

PO Box 372, 219 Route 206, Andover, NJ 07821 U.S.A. 

TEL: (800)-247-8887 / (973)-786-6386 

FAX: (973)-786-7586 

URL: http://www.kanomax-usa.com/ 

E-Mail: info@kanomax-usa.com 

 

 

 JAPAN 

KANOMAX JAPAN INC. 

2-1 Shimizu, Suita City, Osaka 565-0805, Japan 

TEL: 81-6-6877-0183 

FAX: 81-6-6879-5570 

URL: http://www.kanomax.co.jp 

E-Mail: sales@kanomax.co.jp 

 

 

 CHINA 

Shenyang Kano Scientific Instrument Co., Ltd. 

TEL: 86-24-23846440 

FAX: 86-24-23898417 

URL: http://www.kanomax.com.cn/ 

E-mail: sales@kanomax.com.cn 

       01001/1908 
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